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1. Overview

This document suggests a generalised modeling workflow to help jump-start your BIM
eSubmission. The examples used in this document to explain the workflow are based on
Autodesk Revit Structure. Please seek assistance from your preferred vendor if you are using
other BIM software for the eSubmission.

2. Getting Started

The first step is to obtain the "Architectural drawings" and "Site Plan drawings". The examples
found in this document are based on 2D drawings to create the BIM Model.

2.1. Architectural Drawings

It is recommended that you obtain the set of Architectural drawings that will be submitted (or
already submitted) to the regulatory authority for approval. The set of Architectural drawings
should consist of at least the following plans

72 Floor Plans

72 Elevation Plans
? Section Plans
.

Details Plans (optional, but good to have if it helps to explain the project)

Note the set of Architectural drawings used to compile the Structural BIM Model should be
submitted together with the Structural package for regulatory approval.

If you manage to obtain the Architectural BIM model, it should contain “Structural Discipline”
attributes in the Revit objects. Otherwise, you will have to add in the attributes. The following
figures illustrate the difference in information between Architectural and Structural BIM.

Example:

Differences between

Architectural and

Structural Column

Instance Properties.




Building and Construction » Authority

2.2. Site Plan

These drawings are usually prepared by registered Land Surveyors or Architects. Obtain the
following information from the drawing and enter them into your BIM model

2 Coordinates (X,Y,Z) of Survey Datum
72 Bearing and Distance of all project site boundary
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3. Modeling your Project

3.1. Families and Family Types

This section highlights the basic elements required for a Structural BIM. There might be
additional objects required and it depends on the project.

Note: Model only the “Structural” objects and not Windows, Doors and Building Facades.

Families Families Type
1 g ' Concrete - Rectangular Beam h“/ H-Wide Flange Beams
Beam —
2 Q Q Structural Wall
Wall

U Structural Column

4; Structural Floor @ Slab Edge

N
[
I =}
| |Ee
3

Tl pile Cap-9 Pile [ ’ Pile Cap-Rectangular

[zolated

Woall Foundation

)=

Wall Bearing Footing - S00 « 300

N

7 ¢~ 7 Foundation Slab @ Slab Edge

Slab

@ @ Flace a Component G': Model In-Place
8

This Family is for non-standard structural
elements as shown in the illustration.

Component

This guide will not go into explaining how you would model with each of the above objects.
Please refer to your software user’s guide. You may follow the modeling sequence found in the
next section to build up your model.



3.2. Modeling Sequence
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Step Description lllustration
e ——
1 Start ReVIt 201 0 and Create neW [@E Creates a new project, family, template or
. annotation symboel.
project. o ,
. . D I'?rg%ﬂ'!\'it roject file,
Menu: R(Application I e L
Icon) >New>Project cesess = ﬁ
1 - Press F1 for more help 2 A
g LIS Y| Title Block &
L_Z)pe_l.ﬂs a template for creating a Title Block i
D — =)
2  Browse and select the ST Template. T
Temp'ate F||e @ C:\ProgramData‘Autodesk\RST 20 10WMetric Te
01.BIMSubmissionTemplate_Struc- © proect empae
Apr11(Revit2010) (it (i) |
Choose the Project option and click R ——
OK to create the project. New project e ey |
will be created as shown in the
illustration.
Note: If you have started the project
without the template then please
refer to the Software User Manual on
how to transfer the project settings.
3 Alternatively you can set the “Default Template File Location” in the “Revit Options”.
Please refer to the Software User Manual on how to set the default.
4 Inthe 1% storey plan view @ @

Create the Project Grids

Refer to Section 4.1




Step Description

5 Create Project Levels

Refer to Section 4.2
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Illustration

RF TERRACE 5
118800

3RD STOREY S
114400

2ND STOREY $
108800

1ST STOREY
D )

6 Create Project Boundaries

Refer to Section 5.1

7 Set the Orientation,
Coordinates & Datum

Refer to Section 5.1 and
5.2

32157.555 ~.
~

13145.680

8 Model Foundations /
Footings

refer to CAD user’s

manual
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Step Description lllustration

9 Model Columns @ @ @ @

refer to CAD user’s \ \ |

manual 7T77j 7777777 W%**
s b
i —
10  Model Beams / Framing 7 W 77777 o . <ﬁ)
e |
refer to CAD user’s lﬁ 7777777 o
manual 1\1 ' -
i i
S

11 Model Walls

refer to CAD user’s

manual

—

12  Model Slabs / Floors

refer to CAD user’s

manual

13  Model Others, such as
Stairs and Voids

refer to CAD user’s

manual

When the model is completed proceed to prepare for BIM eSubmission (refer to section 6, 7 &
8).
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4. Project Grids and Levels

It is recommended to recreate the project grids and levels in your project based on the
information you obtain from the Architectural drawings. This information must be modeled
accurately to avoid issues in the project downstream.

You can attach the architectural drawings as a reference to your project model. But do
remember to "Detach" this reference before your Regulatory Submission; otherwise your file

size will be too large.

4.1. Creating Project Grids

Step | Description llustration

Revit Sample - Project browser
o

1 Double click on the 1* Storey Plan in the

Project Browser to open the view.

2 If the Architectural Floor Plan softcopy (e.g. DWG) is available then link it to the
project.
Menu: Insert2>Link>Link CAD
If the Architectural Revit BIM model is available then link the model to the project.
Menu: Insert>Link>Link Revit

3 Create the grids in 1ST Storey Plan (Level 1).
Menu: Home »Datum->Grid gﬁ
The grids will be shown automatically in rest of

Plans, Sections and Elevations.
Ensure that the grid values are populated Datum

correctly as you draw the grids.

The recommended grid values are alphabets A
for horizontal grids and numeric for vertical | "\\5 /
grids.

4 In case of linked CAD/BIM file, the grids
created in step 3 must coincide with the grids in
the linked file. Otherwise, clarify this with the

Architect and solve the issue before proceeding
further.
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4.2. Creating Project Levels (Storey)

Step | Description lllustration

[Revit Sample - Project browser

1 Double click on one of the Elevation in the
Project Browser to open it.

1l Ex

If the Architectural Elevation softcopy (e.g. DWG) is available then link it to the project.
Menu: Insert>Link>Link CAD

Note: If the Architectural BIM Model has been linked during grid creation step then

skip this step.

3 There will be 5 default levels with 4m default

level helght in the template. Please Change st Sty EXT'G 1ST STOREY LEVEL(107.10)
them to suit your project and align 1ST Storey e
(Level 1) to the linked CAD/BIM file.
4  Create the levels. KPZN gﬁ
Menu: Home>Datum->Level Leval I'God Level
Once the levels are created in the BIM. If there
Datum
is any difference between level of the project
and that of the linked file, please clarify with the 8
Architect. v |PROP. 2ND STOREY LEVEL(111.30) |
U I
Tat Storey EXTG 15T STOREY LEVEL{107.10) |

107109 " g
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5. Project Site Boundary, Orientation and Coordinates

Project Site Boundary must coincide with the Approved Architectural Plans to ensure

consistency with the ST application. This section will explain how you can associate the project

boundary information to your project and all its related settings such as real-world orientation,

coordinates and datum.

5.1. Creating Site Boundary and Orientation Settings

Step |

1

Description

This process is to manage overall
project enclosure. It is not necessary
to copy all the information in the
Survey Plan. You may copy the
boundary line as the minimum.

If there is no softcopy as reference
then the boundary line need to be
created manually.

lllustration

Double click on the Site Plan in the
Project Browser to open it.

Projectl - Project browser
-0, Views [BCAST.BIM.Subm)
+ - Architectural
B Others
Dratting View: 2nd Storey Details
- Site
Structural Plan: STRU_SP Site Pian _
B Structural-3D
30 View: STRU_3D_Model
30 View: STRU_3D_NEW
%) Structural-DT

If the Survey Plan softcopy (e.g. DWQG) is available then link it.

Menu: Insert=>Link=>Link CAD

Note: If the Architectural BIM model is linked in earlier steps then the boundary line

can be obtained from the linked model as well.

If the Survey/Site Plan is not located at
the correct coordinate and orientation
then correct it in the CAD file before
linking.

If the Survey/Site Plan does not have
the grids from the Approved
Architectural Plan then it's
recommended to add the grids in the
CAD file before linking as well.

Pl e S1aPln
| = | P of type: [Dws Fies (.awg) 3
[Fomws e ] 2 o o et [ntn-o0mm crom
Lo [
imcertunts: [t Deter tm
= e forcel
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Step | Description lllustration

5 The grids created earlier and the linked CAD/BIM file might be in a different
orientation. This is because the survey plan is always created in the real north
orientation (Revit Term: True North) and by default the plan views are in user defined
north (Revit Term: Project North). Rotate and Align the linked CAD/BIM file to the
grids.

6 Zoom to a comfortable range in the
view. Create the boundary line using
the Property Line tool.

Menu: Architect &  Site>Modify
Site >Property Line.

Choose “Create by sketching” in the

Create Property Line dialog box.

Trace the boundary line from the
linked CAD/BIM file.

7 Add in the additional information like

e Bearing-distance using the
property tag.

Menu: Annotate-> Tag-> Tag of

¢ Road name
Lot numbers
e Entry/Exit
e (Grid Setting out

R e Y

8 Setting up the True North. RERSINGIE POREIORST | e iew Templte From Vi
. . . . . =) Architectural Dupl\(atEViEw »

Right click on the view in the Project Stucust Pan ARCH Coner toindependent view

Structural Plar: ARCH | Apply Dependent Views...
Browser, Choose Properties from the S 08 Deete

Ele-,at!m AR(H,FE,E_ Copy to Clipboard
context menu. gy

Elevation: ARCH_FE_V E et A neanees
or ¢ Dthenr;aftmg\,riew:Zna St

=) Site Save to New File...

Menu: View=>Graphics 2> View & S [l

Properties




Step |

Description

Instance Properties dialog box will
pop-up.

Choose True North in the Orientation
parameter and apply. Now the view is
set to True North.

Building and Construction

Authority

" Instance Properties [t
Famiy: [System Famiy: Structural Plan - i
Tyoe:  [Structural Plan ¢ [ edtiype.. |
Instance Parameters - Control selected or to-be-created instance
Parameter Value [«
Graphics #
View Scale 1:100
ScaleValue 1 66
Display Model Normal
Detal Level Fine
Visibility/ Graphics Overrides [ Edit... £
WModel Graphics Style Fiidden Line
Graphic Display Options I Edit...
Underlay None
linderiay Orientation Bian
g
Wall Jomn Die m
Discipline
Color Scheme Location Background
Identity Data F
View Name STRU_SP Site Plan

10

Need to rotate the True North to
coincide with the real world north
(survey plan’s north orientation).

Menu: Manage 2Project
Location2>Position>Rotate True

North

The base point for rotation will be
selected automatically. Move the
mouse to see the change in angle.
Key in the angle obtained manually
from the survey plan.

&)
/¥ Relocate Project

1
1. Rotate True North|

g} Miror Proje

&y Stuctural Site Plan

Rotate True North

Changes the angle for a project relative to True North,

11

Toggle between “True North” and
“Project North” in the View Properties
to see the change in angle.

Note: Set True North to the Site Plan
and Project North to the rest of the

plan views.

Revit Sample - Project browser

(-0, {Views (BCASTEIM Subm)
Architectural

o8-8

Structural-30
Structural-DT

0885

Structural-GA
Structural Plan: STRU_FP_Lst Storey
Structural Plan: STRU_FP_2nd Storey
Structural Plan: STRU_FP_3rd Storey
Structural Pla: STRU_FP_4th Storey
Structural Plan: STRU_FR_Roof
B} Working
3D View: STRU_3D_View 02
Drafting View: Staircase Details

Others True North
Site
Structural Plan: STRU_SP_Site Plan -

Structural-EL Project North
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5.2. Coordinates Settings

This section explains how to set the “Real-World Coordinates” for the project.

Note: This need to be done after creating the Project’s grid and boundary.

Step | Description lllustration

1 If the project’s Northing and Easting is
available in the Linked CAD/BIM file as
shown in the illustration then you can
acquire the information directly.

2 Acquire the coordinates from the
linked CAD/BIM file.
Menu: Manage 2>Project

Location>Coordinates 2>Acquire

Coordinates

Pick the Link and it will acquire the
coordinates.

Insert Modify Analyze]
H ﬁ_ Angular -~ Spot Elevation

| & Radial
| 7 Arclength | ™ Spot Slape

I Dimension 'I

3 Use spot coordinate annotation to
verify the value.

4 In case the Northing and Easting is not
correct in the linked CAD/BIM file then
manually specify the coordinate.

Menu: Manage >Project Y
Location>Coordinates 2 Specify Oe.\\_ A\
Coordinate at Point e A /;é

Pick a point in the view to specify the

coordinates.




Step |

Description

Key-in the Northing, Easting and
Datum in the shown dialog box. If
there is no datum value then leave it
as 0.

The project will be relocated to the
established coordinates virtually.

Building and Construction » Authority

lllustration
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6. Preparing the Views for Submission

When the structural model has been completed, you need to prepare the General-Assemblies
(GA) for BIM-eSubmission. These are similar to construction drawings where you typically show
the information in Plan views. Since the project is BIM, Plans, Elevations and Sections can be
generated automatically. Next section explains how to prepare the GA.

Note: Column schedules need to be prepared as per current practice using tools like Detalil
Lines and Texts under the Annotation Menu.

Note: Area loading plan can be created by duplicating the floor plans and using the tools like
Filled Region, Detail Lines and Texts under Annotation Menu.

6.1. Plan Views Preparation

Step Description lllustration

Project browser
STEIMSubm)

1 In the project browser double click in any of the

a: STRU_SP_Site Plan

plan view to open it.

Note: You have to repeat these steps for all the

plan views.

2 The selected plan view will be shown. This view

may look “congested” but can be managed with
the View Template.

3 Right click on the view in the project browser and View Templates
Show type:
choose Apply View Template from the context Floor, Structural, AreaPlans  ~
menu Mames:
' Architectural Plan
BCA-Architectural
BCA-Structural-TT.FL
i “ ” BCA-Structural-GA
In the dialog box select “BCA-Structural-GA et Ay tosl Stk

Structural Foundation Plan
Structural Framing Plan

The settings of the view will be adjusted
automatically and relocated to correct heading in
the project browser.
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Step Description lllustration

4 Add-in all the required annotations. The completed view should look similar to the
illustration below. The tables and notes can be placed in this view as well. Alternatively
place them in the “Sheet View”.

o 1 1
& ! L ®
‘ e ]
[ | [
G I | |
! ra rh ! | ]
Ld L L | [}
- | I
& \| | I |
g | | I
| | |
| | |
| | |
| I I
N - h | [
ol o ]
e I | by
w I | |
| I
el

|
|
|
— “ 1] s 5 _: e T By o————T—F - T-= M- ==
. T - L o !
I ; 'TLI:.HH..H =1
. —_— [JEEEEE RN — -
! I L IR W N R 1
A : ! ﬁif Ly - o)

6.2. Elevation and Sectional Views Preparation

Repeat the steps for Elevation and Sectional views. The view template for Elevation and
Section is “BCA-Structural-EL” and “BCA-Structural-FX” respectively.

Typical completed Elevation and Section were shown below.

GTHAMSL g~
STH Y5500_dil¥,
15000 ™

ATHLEVEL g
11400

1
|
[ 1

I
|
}

T
H=—— e ——1—

I

wOLEVEL g
- %

o _ PNDLEVEL g~
4200 ™

q
q
Ee————

ISTLEVEL g~
i — il — OPLETEVEL K
- —"==8
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6.3. Detail Views Preparation

There are several types of “Detail Views” (DT) need to be prepared for the submission. DT here
refers more to “detailing” rather than actual detail parts and components. For the purpose of
regulatory submission, need to prepare only the “detailing” of the project. Actual detail parts will
be required for exceptional cases. Next section will illustrate how to prepare standard detailing
for the project.

Step ‘ Description \ lllustration

1 Locate the beam in the Plan view to generate
the detail.

Create a detail section

Menu: View->Create—>Section

2 The menu bar will change and display as
shown in the illustration.

=7 Detail View
. Detail
Moadify Element .

Properties ™ Change Element Type

Select “Detail” from the “Change Element

Detail View

Selection
Detail |

Type” drop down menu. =
Building Section
Wall Section
Maost Recently Used Types
Deetail View : Detail
3 Place the “Detail Section Marker” over the 65 !
entire beam that needs to be detailed. BT 200 S 2ou ‘
By default, the limit of this detail section U U

marker may cover more objects. Change the I o
limits by dragging the indicator as shown, to

cover only the items that need to shown in the AV
detail. . )

2VB31 2504600
VB32 260k

2HB3T  250x550 11 2HB38 250550 Ll
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Step \ Description \ lllustration
4 A new Detail View will be created in the S . :;
PrOjeCt Browser. BT 250000
Right click on the view and choose Rename U
from the context menu. T |
s Jr : g
Rename the view as per the BIM Submission B Gmee rsh
L=
I
standard. T == B
L L
Name: | 2vB31] — n
Ce =l |y
5 Double click on the view to open the detail @ @ @
view which will be similar to the illustration | g
shown here. ‘ ‘
| |
\ \ |
N _ 1
‘ ‘ ! [homees g
! I
6 Adjust the limits of the crop view by clicking on ? ? ﬁ)

the external boundary. Drag the indicators to

I ; [ [ L 1 %‘9
cover the view that is required for the detail. ~ ~® \J_'_’—r: O
T . ® .
T

7 Right click on the view and choose properties 1 e Py .
in the context menu. Dpe: (oo o [Cmwen
Instance Parameters - Control selected or to-be-created instance
In the Instance Properties dialog box scroll T T 3
Discipline Structural
. “« . - . Color Scheme Location Background
down to the item “Crop Region Visible” and tientityData 2
|| | View Name 2vE3L
. “ - ependency Independent K
uncheck it, followed by “OK”. it '
T Se
This will remove the boundary box (Crop Box). e ioking
| | Crop View m
Crop Region Visible [l o
Annctation Crop il
Far Clipping Clip without line
Far Clip Offset 7207
Scope Box Hone
Phase Filter Nene i

(2t




Step \
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Description | lllustration

Modify  Analyze  Architect & Site _ Collaborate  View  Manage  Add-ns &

Angular & Spot Elevation |:E‘A] T Filled Region A AQB,C

Radial & Spot Coordinat 1Y Masking Re
ace POtEOOICINSEE | Detsil | Component |  Detail L5 Masking Region Tet  Spelling
- d

and floor extend that is not necessary in the s “sess |52 &t ©) Roon i
e —— < Py | I - -

detail. e omponent
e — Adds a view-specific detail component to a view.

Legend (| Press F1 for more help

Insert break lines to hide the column, frame

Repeatin

Menu: Annotate 2Detail>Component->Detail

Vlan: STRU_SP_Site Plan 3

Component

Place the “Break Line” anywhere in the view.
ROTATE or RESIZE this item depending |
where you want to place. Break line will mask

<

the elements that are not necessary in the

AMmp

view.

10

Completed view should look similar to the

illustration shown here.

11

3D reinforcement feature can be used but not recommend for the entire project as it

will cause the project to be “overloaded”.

12

Given the current technology capacity, it's BCA_ReBar_Typel

recommend that the reinforcement be done BCA_ReBar_Type2

with “Detail Lines”. There are two basic line

TR

! Home ]nserter!lfy Analyze  Architect 8 Site  Collaborate

types in the template and the user is free to P Ay st ecton Al

4 (<, Radial A Spot Coordinatd %
Aligned  Linear Detail | [Component | Detail

include more to support their needs. P ot g | Linm ] ot

Dimension +

Detail

Menu: Annotate>Detail>Detail Line
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Step \ Description \ lllustration
13 In the Line Style select “BCA_ReBar_Type1” .
Home Insert Annotate Modify Analyze Architect & Site  Coll
for main/primary Bars and | B | TB i rae
Modify | Instance |BCA ReBar Type2 e {3 ‘[{ : |
. Properties | oo A
“BCA_ReBar_Type2” for minor/secondary |wew 27
Place Detail Lines | [] <Demolished> o004

bars. Factory_Try01.rvt - Praje <Hidden >
S 0. Views (BCASTEI] <Overnead>
i B Strucural DT[Toee
Dot Vil BCAReBar Typel
Detail Viell{{BCA_ReBar_Type2

| B Structural GA Ree—
' Structural P|
Lines

] »

- Structural P
. & Working Medium Lines
- Structural Pl | jneg
Structural P
-« Structural pf Wide Lines

14  Draw the reinforcements the way it has been

. . 4132 4132
done in 2D drawings. . J
]
1
Include the annotations accordingly. The end I |
result should look similar to the lllustration. * o 2OfgEe - A ]
2XT13-125 2XT10-125

15 The last item need to be included in this view

is the label for the beam detailing.

ﬂ Angular; Flevation . I:FI
Menu: AnnotateéTag 9Tag Ahgned Linear @f‘ g Pms:’p'd'”m D::aew\ compane] |+

1= Horizental Irags"EILeauzr Attached End + I 127 mm ”

Ensure the “Leader” has been unchecked
before tagging the beam.

16  Apply the view template “BCA-Structural- ("?\/ (1
N N4
DT.EL” to relocate the view to the correct - T
heading in the project browser. ) | | ] ;
] !

1 q 7 | |

+ ‘ 2X2T{61250 4120 J ‘

120 ‘

4VB2 400X800
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7. Preparing Sheets for Submission

Your project can contain many views and not all views are necessary for regulatory approval. In
addition, your project may be submitted in different stages. SHEETS will be used to manage the
different stages of submission. Therefore for each ST submission the views attached to
SHEETS will be subjected to regulatory approval. All other views submitted together shall only
be treated as “For Reference”.

Next section provides an overview how you can carry out this task.

Step Description ‘ lllustration

1 In the Project Browser, right-click on the
item “Sheets” and select “New Sheet...”

New sheet will be added into the Sheets. e

New Sheet.
Properties.
Al metric

[ RCAM Struchural Wall Tan-Mark Fi

. . . 7 Instance Properties =
2. Add in the certifications.
Family:  [BCA.ALTitke.metric - [ Load... ]
. . . . Type: [Almem: v] [ Edit Type... ]
SeleCt the tltle bIOCk In the Sheet, rlght ClICk Instance Parameters - Control selected or to-be-created instance
and choose Element properties from the e — |
Scale 11:100 i
context menu. Identity Data
Sheet Name 1st Storey Plan and East Elevation
Sheet Number U}
Select the appropriate certification under e et
Designed By Designer
the section “Other”. The certifications il ]
. . . Sheet Height 5940
available are QP Certification, CD E =
ertification I
Certification and AC Certification. i -
Date/Time Stamp 05/06/10
File Path
Note: Ensure the certification is relevant, Py futher
current and updated before using it.

Add in the information like Names,
Registration Numbers, Project
Reference Number and Number of
Sheets similar to current practice.

Note: The Title Block Family can be
modified to suite your company standard.
(Refer to the Software manual on how to
edit the family)
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Step Description ‘ lllustration
3 Ensure the sheet numbers and Project sheet of [Tola floc]
. BUILDING AND CONSTRUCTION AUTHORITY
Reference numbers on top right hand S e

Project Ref No I I
corner are correct.

o1 Commissloner of Bullding Cortrol

Project browser g
4 Drag the view that is required submission a:g: Ve EASTEN ) 3
into the newly created Sheet. L v 22

Structural Plan: 2MD LEVEL
=~ Warking
Note: The user can drag more than one view T e e
ructural Plan: SITE
Structural Plar: 3RD LEVEL
toa Single sheet. Structural Plan: 4TH LEVEL
Elevation: South
Elevation: West
Graphical Column Schedule: Graphical Column Schedule 1
Section: Section 1
Section: Section 2
Section: Section 3
Section: Section 4
Section: Section 5
Section: Section &
Legends
=3 Schedules/Quantities
Structural Framing Schedule
S
01 - ABC
02 - Unnamed
=2 Families
= Annotation Symbols
Al metric
- RCAM Structural Wall Tan-Mark Ft

m

5 Arrange the views to the relevant location.

Autodesk Revit

Repeat step (1) to (3) for all the sheets that

is required for submission.
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7.1. Renaming Views and Sheets

Next section will explain how to rename the sheets as per the BIM Submission standard.

Step Description ‘ lllustration
1 In the project browser, right click on the — Prisctbrowe : e
=0, Views (BCASTEIM.Subm) -
. [ Structural -DT
relevant view/sheet and choose Rename Sf
[l Structural-GA ose
Structural Plan: 15T LEVEL in erring Views..
from the Context menu. Structural Plan: 2ZMD LEVEL Find fef 2
[El-Working Make Workset Editable
Structural Plan: 0 FILE LEVEL
Structural Plar: SITE Apply View Template...

Structural Plan: 3RD LEVEL

Structural Plan: 4TH LEVEL . .
Structural Plan: 5TH ROOF Create View Template From View...

Apply Default View Template

Structural Plan: 6TH AMSL
3D View: View 1 - Analytical
3D View: {3D} Convert to independent view
Detail View: Detail 0
Elevation: East
Elevation: Morth Delete
Elevation: South

Elevation: West

Graphical Column Schedule
Section: Section 1

Section: Section 2 .
Section: Section 3 Properties...
Section: Section 4
Section:Sections T |
Section: Section & |

Duplicate View »

Apply Dependent Views...

Save to Mew File...

2 Input the name as per BIM submission Rename View [

requirement.

Mame: | FEREFEE]

Repeat the step (1) and (2) until you [ ok || canel |

complete renaming all your sheets

before submission.

Alternatively you can use the schedule “BCA-View-List”. BCA-View-List is in the Project Browser
under Schedules/Quantities.
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8. Exporting to DWF / PDF

The currently endorsed Light-Weight File formats are DWF and PDF. You can refer to Autodesk
and Adobe respectively for more information about these formats. These file formats are
significantly smaller and compact in file size as compared to the BIM Native Files. They are also
non-editable meaning you can be assured your files would not have been tempered with, in the
process of communication. Other benefits include the ability to compare differences between
versions, and general free for all use at no additional cost. For more information, see their

respective website.

Given these fundamentals benefits with Light-Weight File, BIM-eSubmission can now be carried
out without excessively hogging down Internet communication infrastructure. And you can utilize
the current eSubmission infrastructure to perform this task.

You are reminded again to review your project model for completeness, that it has all the
necessary building information for submission, such as Annotations, Dimensions and
Declarations (See Chapters for Respective Regulatory Agency Requirements). And that they
are added onto the equivalent drawing views. QP would then need to perform a few steps to
achieve this task. If you are publishing to PDF, follow the 3-steps below

1. Publish a 2D View of the BIM Native File into a Light-Weight File
2. Publish a 3D View of the BIM Native File into a Light-Weight File

3. Merge both 2D View and 3D View Light-Weight File into 1 Light-Weight File for
Submission

If you are publishing to DWF, you only need to perform 1 step.
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8.1. Publish DWF file

Step Description lllustration
1 From Revit Main Menu, select EXPORT
followed by DWF. e
o
H =
& o~
E-
=1
2 You should see a pop-up dialog similar to one ™= i ——
display here. B e
B DD
. . Include Type Name £
Select the relevant views you want to publish. B | & s ||
-
. . o [ 3
Save the selected views into a SET name. 5 e
] ® :
You can recall this set subsequently if you Do 8
[asote [ o ][ cad ]

wish to reprint. : - _




